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RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the 
TSIP Driver 
Introduction 
For IoT devices, security and real time processing are critical factors. 

This application note describes how to manage keys safely and speed up the encryption/description 
processing in TLS communication by using the Trusted Secure IP (TSIP) module, which is security hardware 
built into RX Family MCUs. This application note also provides concrete implementation examples and 
sample code. With this information, the reader will be able to build an efficient and safe IoT system. 

Operation of the application described in this application note has been verified in FreeRTOS with IoT 
Libraries in which the TSIP driver is installed. Note that “FreeRTOS with IoT Libraries” is FreeRTOS in which 
the libraries required to use IoT services on AWS are installed. 

This allows the OTA demo application to run on FreeRTOS with IoT Libraries in which the TSIP driver is 
installed. 

 
Note:  The application described in this application note uses the iot-reference-rx demo project, which is an 

RX-compatible version of FreeRTOS with IoT Libraries. 
Note that the application described in this application note supports v202210.01-LTS-rx-1.3.0 or a 
later version of iot-reference-rx. 
 

Note : This application note shows an implementation example based on the operating environment of the 
CK-RX65N v1 board and the RYZ014A PMOD module, 
but it can also be utilized with other boards and communication control combinations.  
For each board and communication control combination, please see: 
 
[GitHub] iot-reference-rx/Getting_Started_Guide.md at main · renesas/iot-reference-rx (github.com) 
 

Note : Renesas announces to discontinue the existing Sequans-sourced LTE module known as the part 
number RYZ014A and will no longer be shipping this product. 
With the discontinuation of RYZ014A, the CK-RX65N v1 board will also be discontinued. 
If you are using RYZ014A in a current design or production, the Sequans part numbers, GM01Q is a 
pin and functionally compatible replacement for RYZ014A. 
 
Below Cellular driver of RX family works the below alternate product combination. 

- RYZ014A Cellular Module Control Module ： Sequans GM01Q is the compatible module. 
 

Regarding EOL notice of the RYZ014A, please see : 
[The link] https://www.renesas.com/document/eln/plc-240004-end-life-eol-process-select-part-

numbers?r=1503996 
[The product page] https://www.renesas.com/products/wireless-connectivity/cellular-iot-

modules/ryz014a-lte-cat-m1-cellular-iot-module 
 

Target Device 
RX65N: R5F565NEHDF 

 

  

https://github.com/renesas/iot-reference-rx/releases
https://github.com/renesas/iot-reference-rx/releases
https://github.com/renesas/iot-reference-rx/releases
https://github.com/renesas/iot-reference-rx/blob/main/Getting_Started_Guide.md#getting-started-guide
https://www.renesas.com/document/eln/plc-240004-end-life-eol-process-select-part-numbers?r=1503996
https://www.renesas.com/document/eln/plc-240004-end-life-eol-process-select-part-numbers?r=1503996
https://www.renesas.com/products/wireless-connectivity/cellular-iot-modules/ryz014a-lte-cat-m1-cellular-iot-module
https://www.renesas.com/products/wireless-connectivity/cellular-iot-modules/ryz014a-lte-cat-m1-cellular-iot-module
https://www.renesas.com/products/microcontrollers-microprocessors/rx-32-bit-performance-efficiency-mcus/rx65n-32-bit-microcontrollers-rxv2-core-large-capacity-ram-and-enhanced-security-connectivity-and-hmi
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Documents for Reference 
The application provided by this application note demonstrates an OTA update.  
For detailed procedures for OTA update, refer to the following application note: 

• How to implement FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 
or later) (R01AN7037) 

 

For details on TLS communication using the TSIP driver and the driver’s API, refer to the following 
application note: 

• RX Family TSIP (Trusted Secure IP) Module Firmware Integration Technology (R20AN0548) 
 

For details on firmware update, refer to the following application note: 

• Renesas MCU Firmware Update Design Policy (R01AN5548) 
  

https://www.renesas.com/search?keywords=r01AN7037
https://www.renesas.com/search?keywords=R20AN0548
https://www.renesas.com/search?keywords=R01AN5548
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Notes: 
• AWS™ is a trademark of Amazon.com, Inc. or its affiliates. (https://aws.amazon.com/trademark-

guidelines) 
• FreeRTOS™ is a trademark of Amazon Web Services, Inc. (https://freertos.org/copyright.html) 
• Git® is a trademark of Software Freedom Conservancy, Inc.  

(https://www.git-scm.com/about/trademark) 
• GitHub® is a trademark of GitHub, Inc. (https://github.com/logos) 
• Arm® is a trademark of Arm Limited or its subsidiaries. 

(https://www.arm.com/company/policies/trademarks/guidelines-trademarks) 
• Mbed™ is a trademark of Arm Limited or its subsidiaries. 

(https://www.arm.com/company/policies/trademarks/guidelines-trademarks) 
• OpenSSL™ is a trademark of OpenSSL Software Foundation. 

(https://www.openssl.org/policies/general/TrademarkPolicy.html) 
  

https://aws.amazon.com/trademark-guidelines
https://aws.amazon.com/trademark-guidelines
https://freertos.org/copyright.html
https://www.git-scm.com/about/trademark
https://github.com/logos
https://www.arm.com/company/policies/trademarks/guidelines-trademarks
https://www.arm.com/company/policies/trademarks/guidelines-trademarks
https://www.openssl.org/policies/general/TrademarkPolicy.html
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1. Overview 
1.1 Advantages of TLS Communication Using the TSIP 
The TSIP driver supports API functions related to TLS communication. Using this API offers the following two 
advantages: 

• Advantage 1: Key information in plaintext format is not handled in the TLS protocol processing. 
Therefore, the risk of leaking the customer’s key information stored on the device can be 
reduced. 

• Advantage 2: Hardware acceleration of cryptographic processing is faster than full software 
processing. 

 
1.2 Flow of TLS Communication Using the TSIP 
The following figure shows the flow of TLS communication performed by the demo project provided by this 
application note.  
Note that this flow applies when the RSA key exchange method is used. 

 

Figure 1-1   Flow of TLS Communication Using the TSIP 

1.3 Cipher Suites Supported by the TSIP Driver 
The TSIP driver supports the following cipher suites that are compliant with TLS 1.2: 

• TLS_RSA_WITH_AES_128_CBC_SHA 
• TLS_RSA_WITH_AES_256_CBC_SHA 
• TLS_RSA_WITH_AES_128_CBC_SHA256 
• TLS_RSA_WITH_AES_256_CBC_SHA256 
• TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256 
• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256 
• TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256 
• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256 
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1.4 Definition of Terms 
The following table defines the terms used in this application note.  
For the sections where the listed items are used, refer to Figure 1-1, Flow of TLS Communication Using the 
TSIP. 

Table 1-1   Terms 

Term Description 
Key injection To inject a wrapped key into a device at the factory. 
User key A plaintext crypto key used by the user. This is not used on a device. 

If the key exchange method is RSA or ECC, public and private keys 
are user keys. 

Encrypted key Key information generated by encrypting a user key by UFPK and 
adding a message authentication code (MAC) to it. Encrypted keys 
for the same user key share the same value for each device. 

Wrapped Key Data converted from an encrypted key by key injection so that it can 
be used for the TSIP. Because a wrapped key is wrapped by HUK, 
wrapped keys converted from the same encrypted key have device-
specific values. 

UFPK 
(User Factory Programming Key) 

A user-configured key ring used to generate an encrypted key from a 
user key in key injection. This is not used on a device. 

W-UFPK 
(Wrapped UFPK) 

Key information generated by wrapping a UFPK by HRK on the 
Renesas DLM server. This is decrypted by HRK into a UFPK inside 
the TSIP. 

Hardware Root Key 
(HRK)  

A common crypto key that exists in the TSIP and Renesas secure 
rooms only. 

Hardware Unique Key 
(HUK) 

A device-specific crypto key that is derived in the TSIP and used for 
key protection. 

Wrap (wrapping) In this application note, “wrapping” refers to a process that performs 
UFPK-based encryption and adds a message authentication code 
(MAC) during generation of an encrypted key. 
Because the TSIP driver does not accept a plaintext user key as an 
input, the crypto key to be input must be wrapped. 

Renesas DLM (Device Lifecycle 
Management) server 
(https://dlm.renesas.com/) 

The Renesas key management server used by the Renesas Key 
Wrap service. This is used for UFPK-based wrapping. 

  

https://dlm.renesas.com/
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1.5 Environment in Which Operation Was Verified (Hardware) 
The following table shows the (hardware) environment in which operation of this demo project was verified. 

Table 1-2   Environment in Which Operation Was Verified (Hardware) 

Item Description 
Board used CK-RX65N v1 (Cellular / Ethernet)*1 
Cellular module RYZ014A PMOD module (bundled with CK-RX65N v1) 
SIM SIM (microSIM) card supporting LTE Cat-M1*2 
Debugger Debugger built into the E2 Lite emulator (CK-RX65N v1) 

Notes: 1. The application described in this application note uses cellular communication. 
 2. If you use the SIM card that is bundled with the CK-RX65N v1, activate the SIM card. For details, 

refer to “4.1.5 Activating SIM card” in the following application note: 
SIM activation, Creating the trial account and using Dashboard with RYZ014A or Ethernet 
Application for AWS - Getting Started Guide (R01QS0064) 

 

1.6 Environment in Which Operation Was Verified (Software) 
The following table shows the (software) environment in which operation of this demo project was verified. 

Table 1-3   Environment in Which Operation Was Verified (Software) 

Item Description 
Integrated development environment e2 studio 2024-01 
Compiler RX compiler CC-RX V3.06.00 for e² studio 
FreeRTOS v202210.01-LTS-rx-1.3.0 
Driver package (RDP) RX Driver Package V1.42 
TSIP driver RX Family TSIP (Trusted Secure IP) Module Firmware 

Integration Technology Rev.1.20 
Firmware update module RX Family Firmware Update Module Firmware Integration 

Technology Rev.2.02 
Log monitor tool Tera Term v4.106 
Python runtime environment Python 3.11.0 
Key generation tool Win64 OpenSSL v3.2.1 
PGP encryption/decryption tool Gpg4win (Kleopatra) v4.3.1 
Shell script (bash) execution environment Cygwin version 3.4.6 
Flash memory programming tool Renesas Flash Programmer v3.14.00 
Renesas Image Generator Version 3.03 (bundled with Firmware Update Module 

Rev.2.02) 
Key creation tool Security Key Management Tool V.1.06 

  

https://www.renesas.com/products/microcontrollers-microprocessors/rx-32-bit-performance-efficiency-mcus/ck-rx65n-cloud-kit-based-rx65n-mcu-group
https://www.renesas.com/products/wireless-connectivity/cellular-iot-modules/rtkyz014a0b00000be-pmod-expansion-board-ryz014a
https://www.renesas.com/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756
https://www.renesas.com/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756
https://www.renesas.com/software-tool/e-studio
https://www.renesas.com/software-tool/cc-compiler-package-rx-family#download
https://github.com/renesas/iot-reference-rx/tree/v202210.01-LTS-rx-1.3.0
https://www.renesas.com/software-tool/rx-driver-package
https://www.renesas.com/software-tool/trusted-secure-ip-driver#documents
https://www.renesas.com/software-tool/trusted-secure-ip-driver#documents
https://www.renesas.com/search?keywords=r01an6850
https://www.renesas.com/search?keywords=r01an6850
https://github.com/TeraTermProject/osdn-download/releases
https://www.python.org/downloads/
https://slproweb.com/products/Win32OpenSSL.html
https://www.gpg4win.org/
https://www.cygwin.com/
https://www.renesas.com/software-tool/renesas-flash-programmer-programming-gui
https://www.renesas.com/search?keywords=r01AN6850
https://www.renesas.com/search?keywords=r01AN6850
https://www.renesas.com/software-tool/security-key-management-tool#downloads
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2. Preparation 
Execution of the demo project described in this application note requires the software tools listed in the 
following table. 

Table 2-1   List of Software Tools Required 

Software Tool Name Purpose 
Tera Term This tool is used to view the serial operation log of programs. 
Python This tool is used as an interpreter for running the Renesas Image 

Generator program. 
OpenSSL This tool is used to exchange keys for the TSIP and to generate keys 

for OTA update. 
Gpg4win (Kleopatra) This tool is used to perform PGP-based encryption for a UFPK that is 

used to wrap a key for the TSIP. 
Cygwin This tool is used to execute Bash scripts. 
Renesas Image Generator This tool is used to create a firmware image to be used for OTA 

update. 
Security Key Management Tool This is used to wrap a key for the TSIP. 

 

Some of the above listed software tools are also used for AWS IoT OTA update. For the installation 
procedures of such software tools, refer to the corresponding sections in Chapter 2 in the following 
application note:  
“RX Family How to implement FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-
rx-1.1.3 or later)” (R01AN7037)  
The following shows the relevant software tools and the sections describing the installation procedures: 

• Tera Term: Section 2.1 
• Python: Section 2.2 
• OpenSSL: Section 2.3 
• Renesas Image Generator: Section 2.4 
 

Connection of the target board CK-RX65N v1 is described in section 2.5. When you connect the CK-RX65N 
v1, follow the procedure described in this section. 

  

https://www.renesas.com/search?keywords=r01an7037
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2.1 Installing Gpg4win (Kleopatra) 
In this application note, Gpg4win (Kleopatra) is used in the procedure for encrypting/decrypting a UFPK by 
PGP to generate W-UFPK. 

Install Gpg4win 4.3.1 by using the procedure described below. 

(1) Downloading Gpg4win 

Access the following website that provides GnuPG for Windows:  
https://www.gpg4win.org/ 

Click the Download button shown in the following figure. 

 

Figure 2-1   Downloading Gpg4win (1) 
 
In the window that appears, select $0, and then click the Download button. The installation file is 
downloaded. 

 

Figure 2-2   Downloading Gpg4win (2) 
  

https://www.gpg4win.org/
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(2) Executing the Gpg4win installation 

Make sure that you have the installation file you obtained in section (1), and then run it as administrator. The 
installer starts. Click the Next button. When the following dialog box appears, select the language you want 
to use, and then click the OK button. 

 

Figure 2-3   Installing Gpg4win (1) 
(3) Selecting components 

When the window for selecting the components to be installed appears as shown in the following figure, click 
Next without changing the initial settings. 

In this application note, Kleopatra is used to manage key pairs. Therefore, do not clear the check box of 
Kleopatra. 

 

Figure 2-4   Installing Gpg4win (2) 
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(4) Completing installation 

In all windows that appear before installation finishes, click the Next button. 

When installation is complete, Kleopatra starts. 

 

Figure 2-5   Window for Executing Kleopatra 
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2.2 Initial Setup of the Renesas Key Wrap Service and Kleopatra 
The TSIP adopts a mechanism that prevents plaintext user keys from being exposed externally to protect 
user keys against leakage. This application note shows a method that uses the Renesas Key Wrap service 
to encrypt a UFPK (to generate W-UFPK).  
This section describes the procedure for specifying the initial settings of the Renesas Key Wrap service. This 
section also describes the procedure for using Kleopatra to generate the PGP key that is used during UFPK 
encryption for exchanging files with the service and registering the generated key. 

Use the following procedure to configure and register a key. The information created in this section is used in 
the procedure described in section 5.1.5, Wrapping Keys and Registering Them in the Project. For details on 
keys, refer also to section 5.1.5. 
 
(1) Registering the Renesas Key Wrap service 

When you use the Renesas Key Wrap service for the first time, you must perform user registration and PGP 
key exchange. These tasks are required only the first time. Perform initial registration by logging in at the 
following URL:  
Key Wrap Service Login (renesas.com) 

For details on the Renesas Key Wrap service, refer to the following operation manual:  
KeyWrap Service Operation Manual.pdf (renesas.com) 

When you have completed user registration and the first-time PGP key exchange, log in to the Renesas Key 
Wrap service. 
 
(2) Creating an OpenPGP key pair 

Use Kleopatra to create a key pair in order to exchange public keys with the Renesas DLM server. 
Start Kleopatra, and then, on the page that opens, click the New Key Pair button. The Create OpenPGP 
Certificate dialog box appears. You can create an OpenPGP certificate from this dialog box. Fill in the Name 
and Email address fields. You can optionally select the Protect the generated key with a passphrase 
check box to strengthen security by using a passphrase. Do not forget the passphrase if you set it. 

 
↓ 

 

Figure 2-6   Creating an OpenPGP Key Pair (1)  

https://dlm.renesas.com/keywrap/toEnglish
https://dlm.renesas.com/manual/KeyWrap_Service_Operation_Manual.pdf
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Then, click the Advanced Settings button. 

 

Figure 2-7   Creating an OpenPGP Key Pair (2) 
In the Advanced Settings dialog box that appears, in the Key Material area, select the RSA radio button, 
and then select 4,096 bits. Do not change the other setting items from their initial settings.  
When you have completed the settings, click the OK button. 

Note:  Only RSA keys can be exchanged with the Renesas DLM server. 

 

Figure 2-8   Creating an OpenPGP Key Pair - Advanced Settings 
When the Create OpenPGP Certificate dialog box appears again, click the OK button. Then, the following 
dialog box appears, and generation of a key pair starts. Generation of a key pair takes some time. 

 

Figure 2-9   Generating a PGP Key Pair 
If you have set a passphrase, the window for entering the passphrase appears next. When this window 
appears, enter the passphrase. 
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When the following dialog box appears, a key pair has successfully been created. Click the OK button. The 
Kleopatra main window appears again.  

 

Figure 2-10   Dialog Box Appearing When a Key Pair Was Created Successfully 
The information about created key pairs is registered in the Kleopatra window. Select a key pair, and then 
click the Export button to output the OpenPGP public key. The key pair is saved in a file with the extension 
“.asc”. 

 

 

Figure 2-11   Registered OpenPGP Key Pair 
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(3) Exchanging PGP public key with the Renesas DLM server 

Now you have an OpenPGP public key that was output in section (2). Exchange it for Renesas' PGP public 
key by using the Renesas DLM server. Access the Renesas Key Wrap Service website that you registered in 
section (1), and then click PGP key exchange to register the OpenPGP public key that you created.  
When registration is completed successfully, a Renesas PGP public key (keywrap-pub.key) is sent to your 
email address. When you receive it, save it in any folder of your choice. 

 
↓ 

 

Figure 2-12   Exchanging PGP public Key with the Renesas DLM Server 
(4) Registering the Renesas OpenPGP public key 

The Renesas PGP public key is used to decrypt the key encrypted by PGP on the Renesas DLM server.  
In Kleopatra, register the Renesas PGP public key (keywrap-pub.key) that you received by email.  
In the Kleopatra window, click Import. 

 

Figure 2-13   Registering the Renesas OpenPGP Public Key 
  

https://dlm.renesas.com/keywrap/menu/select/
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When the Select Certificate File dialog box appears, select Any files (*) as the file extension, specify 
keywrap-pub.key, which is the PGP public key sent from Renesas, and then click the Open button. 

 

Figure 2-14   Specifying the OpenPGP Public Key Sent from Renesas 
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If the You have imported a new certificate (public key) dialog box shown in the following figure appears, 
click the Certify button. In the Certify Certification dialog box that appears, confirm that the certificate that 
you registered yourself is selected, and then click the Certify button.  
If you have registered a passphrase in section (2), enter the passphrase. 

 
↓ 

 
Figure 2-15   Importing the OpenPGP Public Key 

When the Certification successful message box appears, close it by clicking the OK button. Confirm that 
an entry named “keywrap” has been added. If “certified” is displayed in the User-IDs column, import is 
completed. 

 
Figure 2-16   Registered OpenPGP Public Key 
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2.3 Installing Cygwin 
The application described in this application note uses Bash scripts when registering certificates and keys in 
a project (source code). Cygwin is used as the script execution environment. 

Use the following procedure to install Cygwin. 

 

(1) Access the Cygwin download website. 

Cygwin download website 

(2) In the download website, click the following link to download the installer. 

 

Figure 2-17   Downloading Cygwin 
(3) Start the installer, and install Cygwin as instructed by the installer. 

During installation, accept all initial settings in principle except when selecting packages. If necessary 
packages are missing, obtain them. 

 

Figure 2-18   Installing Cygwin 
(4) In the Start menu, click the Cygwin65 Terminal icon, and then confirm that the Cygwin terminal screen 

is displayed. 

  

https://www.cygwin.com/
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2.4 Installing Security Key Management Tool 
The application described in this application note uses Security Key Management Tool to convert key 
information so that it can be used with the TSIP. 

Use the following procedure to install Security Key Management Tool. 

 

(1) Download Security Key Management Tool 

Access the Security Key Management Tool download website, and download the latest version of Security 
Key management Tool for Windows. 

In the following example, version 1.06 is the latest version of Security Key Management Tool. 

 

 

Figure 2-19   Downloading Security Key Management Tool 
(2) When the download is completed, start the installer, and install Security Key Management Tool as 

instructed by the installer. 

(3) After installation is completed, confirm that Security Key Management Tool can be started from the 
Start menu. 

  

https://www.renesas.com/software-tool/security-key-management-tool#downloads
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3. AWS Setup 
To perform demonstration of OTA update as in this application note, you must have an account for 
connecting to AWS. This account is a root user or an IAM user authorized to access AWS IoT and the 
FreeRTOS cloud service. 

For details on the AWS setup procedure, refer to the following application note: “RX Family How to 
implement FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” 
(R01AN7037). The information on the following AWS webpage will also be helpful: 

• “Setting up your AWS account and permissions” 
https://docs.aws.amazon.com/freertos/latest/userguide/freertos-prereqs.html 

 
For the demo application described in this application note to be able to communicate with AWS, the source 
code must be modified. For details on modifying the source code, refer to Chapter 4, Preparing for the Demo 
Project and subsequent sections. 

 

3.1 Settings That Must Be Specified from the AWS Console 
Log in to AWS Console, and then specify the initial settings and other necessary settings. To do so, perform 
the procedure described in Chapter 3 in the following application note: “RX Family How to implement 
FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” 
(R01AN7037). 

The following table lists the AWS settings that must be specified to set up the source code of the project in 
this application note. 

Table 3-1   List of Settings Required for AWS 

Name in AWS Description Remarks 
Things*1 Register the name of a device (thing) to be 

connected to AWS. 
Record the name of the 
thing that you set. 
Refer to: 3.3.2(3) 

Endpoint*1 Register the connection destination (URL) 
in AWS. 

Record the endpoint name 
that you set. 
Refer to: 3.3.3(1) 

Device certificate A client certificate used for connection to 
AWS.  
In this application note, this item is called a 
“client certificate”. 

Download it from AWS and 
save it.*2 
Refer to: 3.3.2(6) 

Public key file A public key used for connection to AWS.  
In this application note, this item is called a 
“client certificate public key”. 

Download it from AWS and 
save it.*2 
Refer to: 3.3.2(6) 

Private key file A private key used for connection to AWS.  
In this application note, this item is called a 
“client certificate private key”. 

Download it from AWS and 
save it.*2 
Refer to: 3.3.2(6) 

Root CA certificate*3 A root CA certificate used for connection to 
AWS. 

Download it from AWS and 
save it. 

Notes: 1. The thing and endpoint names must be registered in the project that is executed later. Record the 
registered names. 

 2. Note that you can download the public and private keys for the client certificate only when 
registering devices in AWS. 

 3. The procedure for downloading a root CA certificate is not covered in the following application 
note: “RX Family How to implement FreeRTOS OTA using Amazon Web Services in RX65N (for 
v202210.01-LTS-rx-1.1.3 or later)” (R01AN7037). The download procedure is described in section 
5.1.2 in this application note. 

  

https://www.renesas.com/search?keywords=r01an7037
https://docs.aws.amazon.com/freertos/latest/userguide/freertos-prereqs.html#freertos-account-and-permissions
https://aws.amazon.com/
https://www.renesas.com/search?keywords=r01an7037
https://www.renesas.com/search?keywords=r01an7037
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4. Preparing for the Demo Project 
This chapter describes how to create the project used for demonstration. 

The CK-RX65N v1 board described in this application note is the cellular version. The RYZ014A board is 
bundled with the CK-RX65N v1 board. Connect the RYZ014A board to the PMOD1 pin of the CK-RX65N v1 
so that the CK-RX65N v1 board can connect to a mobile network. 

For details on connection, refer to section 2.5 in the following application note: “RX Family How to implement 
FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” 
(R01AN7037). 

 

Figure 4-1   Overview of Connections in the Demo Project 
The Demo project is based on the FreeRTOS project. FreeRTOS provides IoT Libraries, which contain 
source code necessary for IoT devices. Mbed TLS in these libraries is used as an open-source cryptographic 
library. 

  

https://www.renesas.com/search?keywords=r01an7037
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In this Demo project, the processing in the Mbed TLS library is partially replaced by TSIP driver’s API 
functions related to TLS communication. The following figure shows the software structure of the Demo 
project. 

 

Figure 4-2   Software Structure of the Demo Project 
The Demo project uses version 1.3.0 of the FreeRTOS project for the RX Family MCU provided by the 
following GitHub repository. 

https://github.com/renesas/iot-reference-rx 
  

https://github.com/renesas/iot-reference-rx
https://github.com/renesas/iot-reference-rx
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4.1 Creating a Workspace 
Start e2 studio and create a new workspace.  
Make sure that the length of the path name (including the folder name) of the workspace does not exceed 35 
characters. This is due to restrictions in e2 studio. Specifying a path name longer than 35 characters causes 
an error when building a project. Also make sure that the path name consists of only ASCII characters. 

The following figure shows an example of creating “C:\workspace” as a new workspace. 

 

Figure 4-3   Dialog Box for Creating a Workspace 

4.2 Downloading the Demo Project 
(1) Cloning the demo project 

Clone the demo project from GitHub (iot-reference-rx: FreeRTOS reference repository). This document 
describes the cloning procedure when Git for Windows is used.  

Start GitBush, and then execute the following command: 

cd c:\workspace 
git clone https://github.com/renesas/iot-reference-rx --recursive 

 

Figure 4-4   Cloning the Demo Project 
Note: 1. Make sure that the length of the path name (including the folder name) of the cloning destination 

does not exceed 35 characters. This is due to restrictions in e2 studio. Specifying a path name 
longer than 35 characters causes an error when building a project. 
In the above example, a clone is created in “C:\workspace”.  

After starting Git Bash, change the current directory to 
“C:\workspace” so that a clone will be created in it.*1 

A clone of the master branch is created. 

https://github.com/renesas/iot-reference-rx
https://gitforwindows.org/
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(2) Folder structure 

The demo project downloaded from GitHub has the folder structure shown below.  
The shown structure covers only important folders. 

The items indicated in red font are either files and folders that have been added to the standard project or 
files and folders that have been modified in the standard project for use with the TSIP driver. To check the 
differences from the standard project in details, use a Diff tool. 

iot-reference-rx 
|--Common 
|  |--common_api/r_common_api_tsip.c/h 
|--Demos 
|  |--key_flash_wr_with_tsip 
|--IDT_config 
|--Middleware 
|  |--mbedtls_config/aws_mbedtls_config_with_tsip.h 
|  |--mbedtls_with_TSIP 
|  |--network_transport/using_mbedtls_pkcs11_with_tsip 
|--Project 
|  |--aws_ether_tsip_ck_rx65n 
|  |--aws_ryz014a_tsip_ck_rx65n 
|  |  |--e2studio_ccrx 
|  |  |  |--src 
|  |  |     |--application_code/main.c 
|  |  |     |--frtos_startup/freertos_start.c 
|  |  |     |--userdata_tsip 
|  |  |--flash_project 
|  |  |--key_crt_sig_generator 
|--boot_loader_ck_rx65n 
|  |--e2studio_ccrx 
|  |  |--src 
|--Test 
|--Tools 
|--Getting_Started_Guide.md 
|--README.md 

Figure 4-5   Folder Structure of the Demo Project 
Major changes made to the standard project (so that the project can be used with the TSIP driver) are as 
follows: 

• The processing of FreeRTOS and Mbed TLS was partially replaced by API functions for the TSIP driver. 
Also, code necessary for this replacement was added. 

• Exclusive access control was added to prevent an access contention for the TSIP driver in a multi-task 
environment. 

• The files and folders in which to save certificates and their signatures were added. 
• Processing to write added key data to data flash memory was added. 
• A folder was added to store the settings files for user keys and certificates used for connection to the 

TSIP driver. 
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The downloaded folders store not only the source code of the demo project, but also tools for configuring the 
demo project. The following table outlines these folders. 

Table 4-1   Content of the demo Project 

Folder name Description 
Common 
Demos 
IDT_config 
Middleware 
Test 
Tool 

These folders store common code used in each project and 
modules such as libraries. 
Links to these folders are created in each project as needed. 

aws_ryz014a_tsip_ck_rx65n This folder stores the cellular connection version of project that 
is compatible with the TSIP used in this application note. 
This folder is imported by using the procedure described 
below. 

aws_ether_tsip_ck_rx65n This folder stores the Ethernet connection version of project 
that is compatible with the TSIP.  
This project can be used using the same procedure as the 
cellular version of project. 

boot_loader_ck_rx65n This folder stores the bootloader project for the CK-RX65N v1 
board used in this application note. 
This folder is imported by using the procedure described 
below. 

flash_project This folder stores the project files for Renesas Flash 
Programmer that is used to write executable files to the CK-
RX65N when performing an OTA update. 

key_crt_sig_generator This folder stores the tools for generating keys and certificates 
used for encryption. This folder also stores the work folders for 
those tools. 
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4.3 Importing a Project 
After you have downloaded a project, import it by using the following procedure. 

(1) Start e2 studio. 

(2) From the File menu, select Import to open the Import dialog box. 

 

Figure 4-6   Opening the Import Dialog Box 
(3) Select Existing Projects into Workspace, and then click the Next button. 

 

Figure 4-7   Importing an Existing Project into a Workspace 
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(4) Select the Select root directory radio button, select the folder in which you created a clone in section 
4.2(1), select the two projects as shown in the following figure, and then click the Finish button. 

• aws_ryz014a_tsip_ck_rx65 
• boot_loader_ck_rx65n 

 

Figure 4-8   Importing the Projects of the Bootloader and Application 
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(5) When the projects are imported successfully, “aws_ryz014a_tsip_ck_rx65” and “boot_loader_ck_rx65n”, 
which are imported projects, are added to the Project Explorer view as shown below.  
If the Project Explorer view is not displayed, click the C/C++ perspective at the top right of the window, 
and then select Window > Show View > Project Explorer. 

 

Figure 4-9   Window after the Projects Are Imported 
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(6) Checking the project environment settings 

For the imported two projects, confirm that “Renesas CC-RX” is set as the toolchain. To do so, in the menu, 
select Project > Properties > C/C++Build > Settings, and then click the Toolchain tab. 

 
Figure 4-10   Checking the Toolchain 

Next, click the Tool Settings tab, select Converter > Output, and then confirm that the Motorola S format 
file check box is selected. 

 
Figure 4-11   Checking the Output Format 
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5. Creating Keys and Certificates 
For the project described in this document, you must create multiple keys and certificates in order to 
establish a TLS connection by using the TSIP and execute an OTA update. 

After you have created the data of keys and certificates, register the data in the project that you imported into 
e2 studio in Chapter 4, Preparing for the Demo Project. The procedure for creating the data of keys and 
certificates is described below. 

5.1 Preparing the Keys and Certificates for the TSIP 
To perform TLS communication by using the TSIP in this sample program, you must register the information 
about the keys and certificates listed in Table 5-1.  
This section describes how to obtain these keys and certificates. This section also describes the procedure 
for converting them for use with the TSIP and the procedure for registering them in the sample application 
project.  
Generate these keys and certificates and register them in the sample application project as instructed in this 
section.  
The table below provides brief explanations on the necessary items and how to obtain them. For the flows of 
creating the keys and certificates listed in Table 5-1, refer to Figure 5-1, Flows of Creating Keys and 
Certificates for Use with the TSIP. 

Table 5-1   Keys and Certificates Used in the Sample Application Project and How to Obtain Them 

Key/certificate How to obtain the item How to install the 
item 

Root CA certificate The user downloads this item from AWS. Use CLI.*1, *2 
Root CA certificate signature data The user creates this item by using 

OpenSSL or a similar tool.*6 
Place the file in the 
appropriate folder in 
the project. 

Root CA certificate public key The user creates this item by using 
OpenSSL or a similar tool.*6 
The user then wraps the created data.*4  
The wrapped data is used as the root CA 
certificate signature verification public key. 

Place the file in the 
appropriate folder in 
the project. 

Client certificate The user downloads this item from AWS 
when registering the device.*5 

Use CLI.*1, *3 

Client certificate public key The user downloads this item from AWS 
when registering the device.*5 
The user then wraps the downloaded 
data.*4 

Place the file in the 
appropriate folder in 
the project. 

Client certificate private key The user downloads this item from AWS 
when registering the device.*5 
The user then wraps the downloaded 
data.*4 

Place the file in the 
appropriate folder in 
the project. 

Notes: 1. “CLI” here is the name of the command line interface provided by this project. 
For details, refer to section 6.1.5. 

 2. For details on how to install the item from CLI, refer to section 6.1.5(3). 
 3. For details on how to install the item from CLI, refer to section 6.1.5(2). 
 4. For the wrapping procedure, refer to section 5.1.5 and subsequent sections. 
 5. For the download procedure, refer to section 3.1. 
 6. For details on how to create this item by using OpenSSL, refer to section 5.1.4. 
  



RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the TSIP Driver 

R20AN0749EJ0100  Rev.1.00  Page 32 of 102 
Jun.14.24  

5.1.1 Flows of Creating Certificates and Keys 
This section describes the flows of the tasks for obtaining certificates and keys to be performed in this 
application note. These flows are excerpts from the flows shown in Figure 1-1, Flow of TLS Communication 
Using the TSIP. 

The following figure shows the flows of creating the certificates and keys that are listed in Table 5-1 and used 
in the procedures described in this application note. 

 
Figure 5-1   Flows of Creating Keys and Certificates for Use with the TSIP 

Note:  1. The root CA certificate signature verification public key, client certificate public key, or client 
certificate private key is equivalent to an encrypted key in Table 1-1. However, each of these items 
is created as a single file consisting of key information and W-UFPK information, and then 
registered in the code flash memory. 

 

*1 

*1 

*1 
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The following figure shows the flow of creating a UFPK and W-UFPK shown in Figure 5-1. 

 
Figure 5-2   Flow of Creating a UFPK and W-UFPK 

The procedures for obtaining or creating the necessary certificates and keys are described below.  
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5.1.2 Obtaining a Root CA Certificate 
This section describes how to obtain a root CA certificate. The task performed in this section corresponds to 
the range enclosed in the red frame of the flow shown in Figure 5-1. 

 

Figure 5-3   Obtaining a Root CA Certificate 
Obtain the root CA certificate used for connection to AWS. Download the root CA certificate from the 
following URL: 

https://docs.aws.amazon.com/iot/latest/developerguide/server-authentication.html#server-authentication-
certs 

Because an RSA certificate is used in this project, download “Amazon Root CA 1”. If the web browser you 
are using is Edge, you can download it by right-clicking the link and selecting Save link as. 

 

Figure 5-4   Downloading the Root CA Certificate 
  

https://docs.aws.amazon.com/iot/latest/developerguide/server-authentication.html#server-authentication-certs
https://docs.aws.amazon.com/iot/latest/developerguide/server-authentication.html#server-authentication-certs
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Confirm that the following file is downloaded: 

• AmazonRootCA1.pem 
 

After downloading the certificate, place it in the location indicated in red font in the following figure. Note that 
the key_crt_sig_generator folder exists in the aws_ryz014a_tsip_ck_rx65n folder in the project. 

key_crt_sig_generator 
|-- ca 
|   |-- AmazonRootCA1.pem 
|-- ca-sign-keypair-rsa2048 
|-- client-rsa2048 
|-- output 
|-- 1_rsa2048_convertCrt.sh 
|-- convertCrt.sh 

 

5.1.3 Obtaining a Key Pair and Client Certificate for RSA 
This section describes how to obtain a key pair (client certificate public and private keys) and certificate for 
RSA. The task performed in this section corresponds to the range enclosed in the red frame of the flow 
shown in Figure 5-1. 

 
 

Figure 5-5   Obtaining a Client Certificate/Client Certificate Public and Private Keys 
The client certificate and the client certificate public and private keys are automatically generated on the 
AWS server. Register a device (thing) at the AWS IoT Core website. You can download the key pair and 
client certificate when registering the thing. 
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Download these items when you perform the procedures described in section 3.1, Signing in to the AWS 
Console to section 3.3, Registering your device in AWS in the following application note: “RX Family How to 
implement FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” 
(R01AN7037). 

 

Figure 5-6   Downloading Keys and a Certificate 
  

1. Client certificate 

2. Client certificate public key 

3. Client certificate private key 

https://www.renesas.com/search?keywords=r01an7037
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You can download three files described in the following table. 

Table 5-2   List of Files to Be Downloaded 

No. Name File name Name in this application note 
1 Device certificate xxx-certificate.pem.crt Client certificate 
2 Public key file xxx-public.pem.key Client certificate public key 
3 Private key file xxx-private.pem.key Client certificate private key 

Notes: 1. You can download key pair files only when creating a thing from AWS Console. 
 2. In the above, xxx is an arbitrary character string. 
 

After downloading the certificate and keys, place them in the locations indicated in red font in the following 
figure under the key_crt_sig_generator folder in the project. 

key_crt_sig_generator 
|-- ca 
|   |-- AmazonRootCA1.pem 
|-- ca-sign-keypair-rsa2048 
|-- client-rsa2048 
|   |-- xxx-certificate.pem.crt 
|   |-- xxx-public.pem.key 
|   |-- xxx-private.pem.key 
|-- output 
|-- 1_rsa2048_convertCrt.sh 
|-- convertCrt.sh 
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5.1.4 Generating a Signature of the Root CA Certificate 
This section describes how to perform registration in the project (source code) by using the downloaded root 
CA certificate. The task performed in this section corresponds to the range enclosed in the red frame of the 
flow shown in Figure 5-1. 

 

Figure 5-7   Creating a Signature of the Root CA Certificate 
Convert the certificate by using the procedure described later.  
When performing this conversion, execute the script file provided in the key_crt_sig_generator project 
folder. Note that the script file contains a Bash shell script.  
This application note shows an example in which Cygwin is used to provide a Unix-like interface. Prepare an 
environment in which Cygwin can operate by referring to section 2.3. 

Before executing the script, place the key files in the appropriate folders by using the procedures described 
in section 5.1.2 and section 5.1.3. 

[Note] When executing the script, be sure to refer to section 6.1.5(6) and delete the data flash when 
executing the program. 
Also, please perform the series of operations from section 5.1.4 to section 5.1.5 consecutively. 
Partial steps can produce inconsistent data. 

 

(1) Converting the Root CA Certificate for RSA 

Execute the script provided by this project. In this script, the root CA certificate for RSA is converted into the 
DER format.  
Next, a signature of the root CA certificate and a key pair used for signature verification (root CA certificate 
public and private keys) in RSA-2048 format are generated. Then, the generated root CA certificate private 
key is used to generate the root CA certificate signature data.  
The signature data after conversion has been converted in the array format in C language so that it can be 
registered in the source code of the project. 

Activate Cygwin, and then move to the key_crt_sig_generator folder in the project by entering the following 
command: 

cd /cygdrive/c/workspace/key_crt_sig_generator 
Note:  The above command line applies when the script file is placed in the 

workspace/key_crt_sig_generator folder. 
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Execute the script by entering the following command: 

./1_rsa2048_convertCrt.sh 

 

Figure 5-8   Executing the Script 
 
(2) Registering the converted files in the project 

After executing the script, six files (indicated in blue or red font in the following figure) are generated in the 
key_crt_sig_generator/output folder. 

key_crt_sig_generator 
|-- ca 
|-- ca-sign-keypair-rsa2048 
|   |-- rsa2048-private.pem 
|   |-- rsa2048-public.pem 
|-- client-rsa2048 
|-- output 
|   |-- AmazonRootCA1_crt.der 
|   |-- AmazonRootCA1_crt_array.txt 
|   |-- AmazonRootCA1_sig.sig 
|   |-- AmazonRootCA1_sig_array.txt 
|--1_rsa2048_convertCrt.sh 
|--convertCrt.sh 

The six generated files are described in the following table. 

 

Table 5-3   Description of the Converted Files 

Name File name 
Root CA certificate private key (in PEM format) rsa2048-private.pem 

Root CA certificate public key (in PEM format) rsa2048-public.pem 

Root CA certificate data (in DER format) AmazonRootCA1_crt.der 

Root CA certificate data 
(coded as an array of type uint8_t in C language) 

AmazonRootCA1_crt_array.txt 

Root CA certificate signature data signed by the private key AmazonRootCA1_sig.sig 

Root CA certificate signature data signed by the private key 
(coded as an array of type uint8_t in C language) 

AmazonRootCA1_sig_array.txt 

 

Of the above output files, AmazonRootCA1_sig_array.txt is the root CA certificate signature data signed by 
the private key.  
This file contains generated binary data coded as an array of type uint8_t in C language. When 
AmazonRootCA1_sig_array.txt is generated, copy it to the following folder in the project, overwriting the 
file with the same name: 

\iot-reference-rx\ 
Projects\aws_ryz014a_tsip_ck_rx65n\e2studio_ccrx\src\userdata_tsip 
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Also, the root CA certificate public key file (rsa2048-public.pem) and the root CA certificate private key file 
(rsa2048-private.pem) are generated in the key_crt_sig_generator/ca-sign-keypair-rsa2048 folder.  
The public key file will later be used when the root CA certificate signature verification public key is 
generated in section 5.1.5. 

 

5.1.5 Wrapping Keys and Registering Them in the Project 
Wrap the root CA certificate public key, client certificate public key, and client certificate private key that you 
generated, and then register them in the project (source code).  
These three keys are user keys. 

In this section, you use the following keys: the root CA certificate public key generated in section 5.1.4; and 
the client certificate public and private keys downloaded from AWS in section 5.1.3. 

 

5.1.5.1 Overview of Wrapping Keys 
Because the TSIP driver does not accept a plaintext user key as an input, the user key must be wrapped in a 
format that can be accepted by the TSIP driver. 

Keys used for TLS communication are generally provided in PEM format in the same way as certificates. For 
a key to be used for the TSIP driver, extract the data of the key from the PEM-formatted key file. Then, wrap 
the key by using the Renesas Key Wrap service (Renesas DLM server) and Security Key Management Tool. 
Note that to exchange key data by using the Renesas Key Wrap service, the data must be encrypted by 
OpenPGP. 

An overview of the procedure is as follows. The detailed steps are given later. 

1. Use Security Key Management Tool to create a plaintext UFPK. 
2. Use Kleopatra to encrypt the UFPK by PGP (so that it can be handled by Key Wrap). 
3. Send the PGP-encrypted UFPK to Renesas by using the Renesas Key Wrap service. 
4. Re-encrypt the PGP-encrypted UFPK on the Renesas DLM server (a hardware root key (HRK) is used 

internally in Renesas). 
5. Receive the Renesas-encrypted UFPK (UFPK encrypted by PGP for transmission). 
6. Use Kleopatra to decrypt the PGP encryption and obtain an encrypted UFPK (W-UFPK). 

 

Figure 5-9   Procedure for Generating a UFPK/W-UFPK 
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7. Use Security Key Management Tool to wrap the user keys (root CA certificate public key, client certificate 
public key, and client certificate private key) by using the UFPK (generate an encrypted key). Combine 
the encrypted key with a W-UFPK into a key that will be used after wrapping. 

8. Register the wrapped encrypted key files in the source code. 

 
 

 

Figure 5-10   Procedure for Wrapping Key Information 
Three encrypted keys (root CA certificate signature verification public key, client certificate public key, and 
client certificate private key) are generated as wrapped keys, which are encrypted chip-specific keys, inside 
the TSIP by using an HRK and HUK.  
The wrapped keys are decrypted by the processing inside the TSIP and the decrypted keys are used for 
connection to AWS.  
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5.1.5.2 Generating a UFPK and W-UFPK 
This section describes how to generate a UFPK (user factory programming key) and W-UFPK (a UFPK 
wrapped by the Renesas Key Wrapping service), which are used to wrap keys. The task performed in this 
section corresponds to the flows shown in Figure 5-2. 

Generate your own UFPK, and then upload it to the DLM server to generate a W-UFPK. A UFPK is a key 
used to wrap a public key for verifying a signature.  
You can use Security Key Management Tool to create a UFPK in a format that can be accepted by the DLM 
server.*1 

Once you create a UFPK and W-UFPK, you do not need to create them again. 

Note:  1. This section describes the procedure for generating a UFPK that is to be used for key wrapping 
and an encrypted UFPK (W-UFPK). 
The key information generated by this procedure is sample information. Therefore, it cannot be 
used for actual operation. 
To use keys for mass production, you must generate your own keys. Details on how to do so are 
described in another application note provided by Renesas. 
If you have already used Renesas MCUs or you plan to adopt Renesas MCUs, Renesas provides 
that application note. If you want to reference it, contact the relevant Renesas sales office. 
https://www.renesas.com/contact/ 

  

https://www.renesas.com/contact/


RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the TSIP Driver 

R20AN0749EJ0100  Rev.1.00  Page 43 of 102 
Jun.14.24  

(1) Preparing tools 

The following tools are used to wrap a key. Make sure that these tools are ready for use by performing the 
relevant setup procedure for each tool described in this document. 

• Gpg4win (Kleopatra): Refer to section 2.1. 
• Renesas Key Wrap service: Refer to section 2.2. 
• Security Management Tool: Refer to section 2.4. 
 

(2) Setting up Security Key Management Tool (SKMT) 

Start Security Key Management Tool that you installed, click the Overview tab, and then, from the Select 
MCU/MPU and security engine drop-down list, select RX Family, TSIP. 

  

Figure 5-11   Selecting the MCU and Security Engine 
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(3) Creating a plaintext UFPK 

This section describes how to create a UFPK. The task performed in this section corresponds to the range 
enclosed in the red frame of the flow shown in Figure 5-2. 

 

Figure 5-12   Generating a Plaintext UFPK 
In the Security Key Management Tool application, click the Generate UFPK tab, and then specify the 
following settings: 

• User Factory Programming Key Select Generate random value. 

• Output file Set the file to which the generated UFPK is to be output. You 
can specify a file in any folder of your choice. In this example, 
the file is named “sample.key”. 
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When you have completed the settings, click the Generate UFPK key file button. A UFPK is output to the 
specified folder. 

  

Figure 5-13   Generating a UFPK by Using the Security Key Management Tool 
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When the following message is displayed at the bottom of the window, the file has been successfully 
generated. Confirm that the sample.key file has been output to the specified folder. 

 

Figure 5-14   Output Result Message 
(4) Encrypting the UFPK by PGP 

This section describes how to encrypt the sample.key UFPK file (created in section 5.1.5.2(3)) by using an 
OpenPGP key pair created with Kleopatra and a PGP public key that you received from Renesas in return 
for your own key. The task performed in this section corresponds to the range enclosed in the red frame of 
the flow shown in Figure 5-2. 

 

Figure 5-15   PGP Encryption of a UFPK 
 

In the Kleopatra window, click the Sign/Encrypt button. When the dialog box for selecting a file appears, 
specify sample.key. 

 

Figure 5-16   Encrypting the “sample.key” file 
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The Sign/Encrypt Files dialog box for the selected file appears. This dialog box asks you whether to 
perform signature and encryption. In this dialog box, specify the key pair and key that you created as follows: 

• Sign as: Specify your own OpenPGP public key that you created in section 2.2(2). 
• Encrypt for me: Specify your own OpenPGP public key that you created in section 2.2(2). 
• Encrypt for others: Specify the Renesas PGP public key (keywrap) that you registered in section 2.2(4). 
 

Set the output destination folder in Output files/folder, and then click the Sign/Encrypt button. A file named 
sample.key.gpg is created in the specified folder. This file is a UFPK encrypted by PGP (W-UFPK). 

 
Figure 5-17   Encrypting the “sample.key” File by PGP 

(5) Encrypting the PGP-encrypted UFPK on the DLM server 

This section describes how to encrypt the PGP-encrypted UFPK by using the Renesas Key Wrap service. 
The task performed in this section corresponds to the range enclosed in the red frame of the flow shown in 
Figure 5-2. Within the DLM server, a hardware root key (HRK) is used for encryption. 

 

Figure 5-18   Uploading the UFPK for Encryption 
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Log in to the Renesas Key Wrap service website, and then click RENESAS RX on the top page. 

 

Figure 5-19   Selecting the Type (Family) of the Encryption-Target MCU 
When the following device selection screen appears, click RX65N/RX651 Encryption of customer’s data. 

 

Figure 5-20   Selecting the Device Group 

Click the Encryption service for products link. 

 

Figure 5-21   Selecting the Encryption Service 
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When the following upload screen appears, click the Reference button. Then, specify the sample.key.pgp 
file that you created in section 5.1.5.2(4), and click the Settle button. 

 

Figure 5-22   Uploading a UFPK 
When an upload finishes, the following screen appears, and encryption starts on the Renesas DLM server.  
When encryption finishes, the sample.key_enc.key.pgp file is sent from Renesas to you by email. Save the 
file in any folder of your choice. 

 

Figure 5-23   Screen Appearing When an Upload to the DLM Server Finishes 
(6) Decrypting “sample.key_enc.key.pgp” by OpenPGP 

The sample.key_enc.key.pgp file sent from Renesas is a PGP-encrypted W-UFPK. Decrypt it by using your 
own OpenPGP key to create a normal W-UFPK (encrypted UFPK). The task performed in this section 
corresponds to the range enclosed in the red frame of the flow shown in Figure 5-2. 

 

Figure 5-24   Creating a W-UFPK 
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In Kleopatra, click the Decrypt/Verify button, and then, in the file selection screen, select 
sample.key_enc.key.pgp. Decryption starts.  
When decryption finishes and a message to that effect appears, click the Save All button to save the 
decrypted key. The decrypted file (sample.key_enc.key) is output to the folder that stores the file before 
decryption (sample.key_enc.key.pgp).  
Encryption of sample.key is now complete. The sample.key_enc.key file is a W-UFPK. 

 
↓ 

 

Figure 5-25   Creating a W-UFPK by PGP Decryption 
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5.1.5.3 Wrapping Key Data 
This section describes how to convert the data of the root CA certificate public key (root CA certificate 
signature verification public key), client certificate public key, and client certificate private key into data to be 
registered in the project. This conversion requires sample.key (as a UFPK) and sample.key_enc.key (as a 
W-UFPK) that you created in section 5.1.5.2, Generating a UFPK and W-UFPK.  
The conversion wraps the three keys by using the UFPK, and then combines them with the W-UFPK. 

(1) Key data used 

From the root CA certificate public key you generated (in section 5.1.4, Generating a Signature of the Root 
CA Certificate) and the PEM-formatted client certificate public and private keys you obtained from AWS (in 
section 5.1.3, Obtaining a Key Pair and Client Certificate for RSA), extract the root CA certificate public key, 
client certificate public key, and client certificate private key. The files of these three keys are as follows: 

• Root CA certificate public key file (PEM) 
/key_crt_sig_generator /ca-sign-keypair-rsa2048 /rsa2048-public.pem 

• Client certificate public key file (PEM) 
/key_crt_sig_generator /client-rsa2048 /xxxx-public.pem.key 
Note: In the above, xxxx is an arbitrary character string. 

• Client certificate private key file (PEM) 
/key_crt_sig_generator /client-rsa2048 /xxxx-private.pem.key 
Note: In the above, xxxx is an arbitrary character string.  

Note: Wrap the above three keys by using the following two keys, which were created in section 5.1.5.2: 
• UFPK (sample.key) 
• W-UFPK (sample.key_enc.key) 
The keys used in this section are enclosed in red frames in the following figure.  
The same UFPK and W-UFPK are used to wrap the root CA certificate signature verification public key, 
client certificate public key, and client certificate private key. 

 

Figure 5-26   Key Data Used in This Section  



RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the TSIP Driver 

R20AN0749EJ0100  Rev.1.00  Page 52 of 102 
Jun.14.24  

Enter the file names of these keys in Security Key Management Tool to generate wrapped key files.  
The key files generated here are keys (encrypted keys) wrapped by using a UFPK and combined with a W-
UFPK. The generated key files are source code that can be installed in the project.  
The W-UFPK is used to remove the wraps by the processing inside the TSIP. 

The above key files are specific to the device (thing) created on AWS. You must re-wrap the key files each 
time you connect to a different device. 

The following shows the procedure for wrapping key files. 

(2) Generating a root CA certificate signature verification public key 

Generate a root CA certificate signature verification public key. The task performed in this section 
corresponds to the range enclosed in the red frame of the flow shown in Figure 5-1. 

 

Figure 5-27   Generating a Root CA Certificate Signature Verification Public Key 
Create a root CA certificate signature verification public key to be installed in the project, by wrapping the 
following root CA certificate public key file: 

/key_crt_sig_generator /ca-sign-keypair-rsa2048 /rsa2048-public.pem 
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1. In the Security Key Management Tool application, open the Wrap key tab. Then, in the Key Type tab, 
select the RSA radio button, and select “2048bits, public” from the drop-down list. 

  

Figure 5-28   Wrapping a Public key by Using Security Key Management Tool 
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2. Register the UFPK and W-UFPK. In the Wrapping Key area, select the UFPK radio button, and then 
perform the following operations:  
You have a UFPK named sample.key and a W-UFPK named sample.key_enc.key created in section 
5.1.5.2. Specify the UFPK in the UFPK File field and the W-UFPK in the W-UFPK File field by clicking 
the Browse button for each field.  
In the IV area, select the Generate random value radio button. 

 

   

Figure 5-29   Specifying the UFPK and W-UFPK 
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3. Click the Key Data tab.  
Select the File radio button, and then click the Browse button. 

 
Figure 5-30   Selecting the Root CA Certificate Public Key 

When the dialog box for selecting the key data file opens, select PEM key data (*.pem) as the file type. This 
allows you to find the root CA certificate public key file (in PEM format) easily. Select the following file, and 
then click the Open button:  
key_crt_sig_generator/ca-sign-keypair-rsa2048/rsa2048-public.pem 

 
Figure 5-31   File Selection Dialog Box  
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4. In the Output area, from the Format drop-down list, select C Source.  
In the File text box, select any folder of your choice, and then enter the following file name:  
encrypted_user_rsa2048_ne_key.c  
In the Key name text box, enter the following string:  
encrypted_user_rsa2048_ne_key  
When entry is complete, click the Generate file button to generate the root CA certificate signature 
verification public key. 
Note:  Always enter the indicated strings without change because they are strings that are hard-coded in 

the source code. 

  
Figure 5-32   Generating the Data of the Root CA Certificate Signature Verification Public Key 

When the following message is displayed at the bottom of the window, the file has been successfully 
generated. Confirm that the following file has been output to the specified folder:  
encrypted_user_rsa2048_ne_key.c/h  

The root CA certificate public key generated here will be used as the root CA certificate signature verification 
public key in the project. 

 
Figure 5-33   Output Result Message  
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(3) Generating a client certificate public key 

This section describes how to generate a client certificate public key. The task performed in this section 
corresponds to the range enclosed in the red frame of the flow shown in Figure 5-1. 

 

Figure 5-34   Generating a Client Certificate Public Key 
Wrap the following key file to create a client certificate public key to be installed in the project: 

/key_crt_sig_generator / client-rsa2048 / xxxx-public.pem.key 

Note:  This is a file that was downloaded from AWS. The xxxx portion is an arbitrary character string. 
 

1. Generate a client certificate public key.  
First, rename xxxx-public.pem.key to xxxx-public.pem.  
Then, open the Key Type tab, and make sure that the RSA radio button and 2048bits, public are 
selected in the same way as in (2). For the Wrapping Key and IV areas, specify the same settings that 
were specified in (2). 
 

 

Figure 5-35   Confirming the Settings in the “Key Type” Tab 
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2. Open the Key Data tab again.  
Click the Key Data tab.  
Select the File radio button, and then click the Browse button.  
When the dialog box for selecting the key data file opens, select PEM key data (*.pem) as the file type. 
This allows you to find the client certificate public key file (in PEM format) easily. Select the following file, 
and then click the Open button:  
key_crt_sig_generator / client-rsa2048 / xxxx-public.pem 

 

Figure 5-36   File Selection Dialog Box 
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3. In the Output area, from the Format drop-down list, select C Source.  
In the File text box, select any folder of your choice, and then enter the following file name:  
encrypted_user_rsa2048_ne_key2.c  
In the Key name text box, enter the following string:  
encrypted_user_rsa2048_ne_key2  
When entry is complete, click the Generate file button to generate client certificate public key data. 
Note:  Always enter the indicated strings without change because they are strings that are hard-coded in 

the source code. 

  

Figure 5-37   Generating the Data of a Client Certificate Public Key 
When the following message is displayed at the bottom of the window, the file has been successfully 
generated. Confirm that the following file has been output to the specified folder:  
encrypted_user_rsa2048_ne_key2.c/h 

 

Figure 5-38   Output Result Message 
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(4) Generating a client certificate private key 

This section describes how to generate a client certificate private key. The task performed in this section 
corresponds to the range enclosed in the red frame of the flow shown in Figure 5-1. 

 

Figure 5-39   Generating a Client Certificate Private Key 
Wrap the following key file to create a client certificate private key to be installed in the project: 

/key_crt_sig_generator / client-rsa2048 / xxxx-private.pem.key 

Note:  This is a file that was downloaded from AWS. The xxxx portion is an arbitrary character string. 
 

1. Generate a client certificate private key.  
First, rename xxxx-private.pem.key to xxxx-private.pem.  
Open the Key Type tab, and then select the RSA radio button and 2048 bits, private.  
For the Wrapping Key and IV areas, specify the same settings that were specified in (2). 
 

 

Figure 5-40   Confirming the Settings in the “Key Type” Tab 
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2. Open the Key Data tab again.  
Click the Key Data tab.  
Select the File radio button, and then click the Browse button.  
When the dialog box for selecting the key data file opens, select PEM key data (*.pem) as the file type. 
This allows you to find the client certificate private key file (in PEM format) easily. Select the following file, 
and then click the Open button:  
/key_crt_sig_generator/client-rsa2048/xxxx-private.pem 

 

Figure 5-41   File Selection Dialog Box 
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3. In the Output area, from the Format drop-down list, select C Source.  
In the File text box, select any folder of your choice, and then enter the following file name:  
encrypted_user_rsa2048_nd_key.c  
In the Key name text box, enter the following string:  
encrypted_user_rsa2048_nd_key  
When entry is complete, click the Generate file button to generate client certificate private key data. 

 
Note:  Always enter the indicated strings without change because they are strings that are hard-coded in 

the source code. 
 

 

Figure 5-42   Generating the Data of a Client Certificate Private Key 
When the following message is displayed at the bottom of the window, the file has been successfully 
generated. Confirm that the following file has been output to the specified folder:  
encrypted_user_rsa2048_nd_key.c/h 

 

Figure 5-43   Output Result Message 
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Use the procedures shown in (2) to (4) to register the following wrapped key files in the source code. The 
task performed in this section corresponds to the range enclosed in the red frame of the flow shown in Figure 
5-1. 

 

Figure 5-44   Registering Generated Key Data in the Source Code 
 

The following table lists the files of generated keys. 

Table 5-4   List of Wrapped Key Files 

Name File name 
Root CA certificate signature verification public key - encrypted_user_rsa2048_ne_key.c 

- encrypted_user_rsa2048_ne_key.h 
Client certificate public key - encrypted_user_rsa2048_ne_key2.c 

- encrypted_user_rsa2048_ne_key2.h 
Client certificate private key - encrypted_user_rsa2048_nd_key.c 

- encrypted_user_rsa2048_nd_key.h 
 
Copy the above six files to the following user data folder in the project, overwriting the existing files with the 
same names: 

\iot-reference-
rx\Projects\aws_ryz014a_tsip_ck_rx65n\e2studio_ccrx\src\userdata_tsip 
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5.2 Generating a Key Pair and Certificates for an OTA Update 
In an OTA firmware update, certificates and a key pair are used to verify whether the firmware used has not 
been subject to tampering. 

Generate ECDSA certificates and keys by performing the procedure described in section 4.1, Generating 
Key pairs and certificates in the following application note: “RX Family How to implement FreeRTOS OTA 
using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” (R01AN7037). 

The following ECDSA certificates, public key, and private key are generated. These items will be used in the 
settings when building a project and creating an OTA job for AWS. 

• ECDSA public key: secp256r1.publickey 

• ECDSA private key: secp256r1.privatekey 

• ECDSA certificate (key pair certificate): secp256r1.crt 

• ECDSA certificate chain: ca.crt 

 

  

https://www.renesas.com/search?keywords=r01an7037
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6. Building a Project 
You created projects in Chapter 4, Preparing for the Demo Project, and certificates and keys in Chapter 5, 
Creating Keys and Certificates. Next, you use these items to create a project that demonstrates OTA update 
using the TSIP. 

The following two kinds of firmware are required to demonstrate OTA update. In this chapter, you create the 
two kinds of firmware from the project. 

• Initial firmware 
• Update firmware 
 
6.1 Building and Executing the Initial Version of Firmware 
Build the initial version of firmware. 

6.1.1 Importing Projects 
Import the following two projects into e2 studio and specify the initial settings by referring to Chapter 4, 
Preparing for the Demo Project: 

• Bootloader: boot_loader_ck_rx65n 
• Demo application (cellular version): aws_ryz014a_tsip_ck_rx65n 
 

Also, prepare the following seven certificate and key files that were created in Chapter 5, Creating Keys and 
Certificates, and store them in the user data folder: 

1. AmazonRootCA1_sig_array.txt: Root CA certificate signature data 
2. encrypted_user_rsa2048_ne_key.c: Root CA certificate signature verification public key (source file) 
3. encrypted_user_rsa2048_ne_key.h: Same as above (header file) 
4. encrypted_user_rsa2048_ne_key2.c: Client certificate public key (source file) 
5. encrypted_user_rsa2048_ne_key2.h: Same as above (header file) 
6. encrypted_user_rsa2048_nd_key.c: Client certificate private key (source file) 
7. encrypted_user_rsa2048_nd_key.h: Same as above (header file) 
 

User data folder: 

\iot-reference-
rx\Projects\aws_ryz014a_tsip_ck_rx65n\e2studio_ccrx\src\userdata_tsip 

 

The data of these certificates and keys is installed in the program when the demo application is built. 

The key files 2 through 7 are converted into index data that is to be used to inject keys during program 
execution. These files are written to the data flash memory only when the program is executed for the first 
time. 

Note:  1. When the program is executed again, these key files are no longer written to the data flash memory 
and the key index information saved in the data flash memory is fetched for use from the data 
flash memory. 
If the data flash memory is cleared, the key index information is rewritten when the program is 
executed again. 

Note:  2. If you changed the key file, be sure to refer to section 6.1.5(6) and delete the data flash when 
executing the program. 
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6.1.2 Setting Up and Building the Projects 
Specify the settings for executing OTA update in the imported projects, and then build the projects. 

 

(1) Setting a public key in the Bootloader 

Prepare the secp256r1.publickey file (an ECDSA public key created in section 5.2). Open the file with a text 
editor, copy the content, and then paste it under the CODE_SIGNER_PUBLIC_KEY_PEM entry in the 
following file of the bootloader: 

boot_loader_ck_rx65n\src¥key¥code_signer_public_key.h 
 

  
 
 
 
 
 
 
 

 

Figure 6-1   Setting a Public Key in the Bootloader 
  

Caution: Enclose each line in double quotation marks ("..."). Add a backslash (\) at 
the end of each line. Do not fail to do this. 
Do not add a backslash (\) to the last line (-----END PUBLIC KEY-----). 
Format: "xxx ... xxx" \ 



RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the TSIP Driver 

R20AN0749EJ0100  Rev.1.00  Page 67 of 102 
Jun.14.24  

(2) Enabling the OTA update demonstration definition of the demo application 

In the aws_ryz014a_tsip_ck_rx65n\src\frtos_confit\demo_config.h file, set the 
ENABLE_OTA_UPDATE_DEMO definition to 1 (enabled). (By default, this definition is set to 0.) 

 

Figure 6-2   OTA Update Demonstration Definition 
(3) Confirming that the initial version of the Demo application is 0.92 

Confirm that the version definitions in the aws_ryz014a_tsip _ck_rx65n\src\frtos_config\ demo_config.h 
file are as follows: 

• APP_VERSION_MAJOR 0 
• APP_VERSION_MINOR 9 
• APP_VERSION_BUILD 2 

 

Figure 6-3   Version Settings 
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(4) Setting up the “r_cellular” module (FIT module that controls the RYZ014A cellular module) 

Open Smart Configurator (aws_ryz014a_tsip_ck_rx65n.scfg), and then select the Components tab.  
In the “r_cellular” module, set the Access point name, Access point login ID, Access point password, 
and Authentication protocol type configurations according to the SIM card. Also, set the Debug log 
output level configuration to 3. 

 

Figure 6-4   Setting Up the “r_cellular” Module 
After you have changed the settings as described above, click the Generate Code button at the top right of 
the window. The changes (made in Smart Configurator) are applied to the relevant code. 

 

Figure 6-5   Generating Code 
If you use the SIM card bundled with the CK-RX65N, activate it by referring to section 4.1.5, Activating SIM 
card in the following application note: 

SIM activation, Creating the trial account and using Dashboard with RYZ014A or Ethernet Application for 
AWS - Getting Started Guide (R01QS0064) 
  

https://www.renesas.com/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756
https://www.renesas.com/document/qsg/sim-activation-creating-trial-account-and-using-dashboard-ryz014a-or-ethernet-application-aws?r=1611756


RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the TSIP Driver 

R20AN0749EJ0100  Rev.1.00  Page 69 of 102 
Jun.14.24  

(5) Setting the device in the firmware 

1. Open Smart Configurator (aws_ryz014a_tsip_ck_rx65n.scfg), select the Board tab, and then check 
whether “R5F565NEHxFB DUAL” is set in Device. 

 

Figure 6-6   Confirming the Device Setting 
If another device (“R5F565NEHxFB” in this example) has been set, perform the following steps to change 
the setting. 

2. Click the ... button to the right of the Board drop-down list. 

 

Figure 6-7   Changing the Device Setting (1) 
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3. The Change Device dialog box appears.  
From the Target Board drop-down list, select “CK-RX65N(DUAL)”, and then click the Next button. 

- 
 

 

Figure 6-8   Change Device Dialog Box 
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4. If the device is changed, the following dialog box (Found problems) appears. In this dialog box, click 
Next. 

 

Figure 6-9   “Found problems” Dialog Box 

5. When the following dialog box (Change to be performed) appears, select the following check boxes: 
Build Settings > HardwareDebug > Toolchain Settings. Then, clear the ROM to RAM mapped 
section (-rom) and Sections (-start) check boxes. Then, click Finish. 

 

Figure 6-10   “Change to be performed” Dialog Box 
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If you change the device, the following dialog box may appear, asking you whether to retain the current 
target board (“CK-RX65N (V1.02)”). If this dialog box, appears, click the Yes button. 

 

Figure 6-11   Dialog Box Asking Whether to Retain the Target Board 
 

6. The device setting is changed to “R5F565NEHxFB DUAL”. 

 

Figure 6-12   Changed Device Setting 
 
(6) Confirming the device setting in the bootloader 

Open boot_loader_ck_rx65n.scfg, and then select the Board tab. In the same way as in (5), confirm that 
“R5F565NEHxFB DUAL” is set in Device. 

 

Figure 6-13   Device Setting in the Bootloader 
  



RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the TSIP Driver 

R20AN0749EJ0100  Rev.1.00  Page 73 of 102 
Jun.14.24  

(7) Changing the address of the vector table in the firmware (aws_ryz014a_tsip_ck_rx65n) 

In the “aws_ryz014a_tsip_ck_rx65n” project, select Project > Properties. In the properties window that 
appears, select C/C++Build > Settings, and then click the Tool Settings tab. 

 

Figure 6-14   Tool Settings Tab 
In the Settings tree view, select Linker > Section, and then click ... on the right of Sections to open Section 
Viewer. 

 

Figure 6-15   Settings Tree View 
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In the Section Viewer window, change the settings as follows: 

• EXCEPTVECT: 0xFFFFFF80 → 0xFFFEFF80 
• RESETVECT: 0xFFFFFFFC → 0xFFFEFFFC 
When you have completed the settings, click the OK button. 

  

Figure 6-16   Section Viewer 
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(8) Building the projects 

When you have completed all necessary settings, build the bootloader and demo application projects, and 
then confirm that no errors occur. The build results are stored in the following folders: In these folders, .mot 
files are generated as built projects. 

• Bootloader 
\iot-reference-rx\Projects\boot_loader_ck_rx65n\e2studio_ccrx HardwareDebug 
.mot file: boot_loader_ck_rx65n.mot 

• Demo application 
\iot-reference-
rx\Projects\aws_ryz014a_tsip_ck_rx65n\e2studio_ccrx\HardwareDebug 
.mot file: aws_ryz014a_tsip_ck_rx65n.mot 
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6.1.3 Creating the Initial Firmware 
In this section, you create the initial firmware by combining a bootloader (boot_loader_ck_rx65n) and 
firmware (aws_ryz014a_tsip_ck_rx65n). 

Renesas Image Generator is necessary when you create firmware. Install Python and Renesas Image 
Generator by referring to sections 2.2 and 2.4 in the following application note:  
“RX Family How to implement FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-
rx-1.1.3 or later)” (R01AN7037). 

Also, Renesas Flash Programmer is necessary when you write firmware to the target board. 

 

(1) Using Renesas Image Generator to generate the initial firmware 

Store the following files in the Renesas Image Generator installation folder: 

• Build result of the demo application created in section 6.1.2: aws_ryz014a_tsip_ck_rx65n.mot 
• Build result of the bootloader created in section 6.1.2: boot_loader_ck_rx65n.mot 
• ECDSA private key created in section 5.2: secp256r1.privatekey 
 

Open the Command Prompt window, change the current directory to the RenesasImageGenerator 
directory, and then generate the userprog.mot file by executing the following command: 

python image-gen.py -iup aws_ryz014a_tsip_ck_rx65n.mot -ip 
RX65N_DualBank_ImageGenerator_PRM.csv -o userprog -ibp 
boot_loader_ck_rx65n.mot -key secp256r1.privatekey -vt ecdsa -ff RTOS 

Generation of the file takes some time. 

 

Figure 6-17   Generating the Initial Firmware 
Generation is complete when the following message is displayed on the command line: “Successfully 
generated the userprog.mot file.” 

The initial firmware is created with the following file name: 

• userprog.mot 
  

https://www.renesas.com/search?keywords=r01an7037
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(2) Using Renesas Flash Programmer to write the initial firmware to the target board (CK-RX65N) 

1. Install the flash memory programming tool (Renesas Flash Programmer).  
Download “Renesas Flash Programmer V3.14.00 Windows” from the download website of the flash 
memory programming tool, and then install the tool.  

2. Connect the CK-RX65N v1 to a PC by referring to section 2.5 in the following application note: “RX 
Family How to implement FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-
rx-1.1.3 or later)” (R01AN7037). 

3. Start Renesas Flash Programmer, and then open the device erase project (erase.rpj).  
The erase.rpj project is stored in the following folder of the sample program: 
\Projects\aws_ryz014a_tsip_ck_rx65n\flash_project\erase_from_bank1 

 

Figure 6-18   Procedure for Opening “erase.rpj” 
  

https://www.renesas.com/software-tool/renesas-flash-programmer-programming-gui#download
https://www.renesas.com/software-tool/renesas-flash-programmer-programming-gui#download
https://www.renesas.com/search?keywords=r01an7037
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4. Click the Start button to start erasure for the device. 

 
Figure 6-19   Starting Erasure for the Device 

If the E3000107 error message, which states that the device conflicts with the connection information, is 
output, go to step 5. 

5. Open the flash memory programming project (flash_project.rpj).  
The flash_project.rpj project is stored in the following folder of the sample program: 
\Projects\aws_ryz014a_tsip_ck_rx65n\flash_project\ 

   

Figure 6-20   Procedure for Opening “flash_project.rpj”  
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6. Select the firmware to be written.  
Click the Add/Remove Files button, and then Add Files button. In the dialog box that appears, select 
userprog.mot, which is the initial firmware created in section 6.1.3(1). 

 
 

 

Figure 6-21   Selecting the Initial Firmware 
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7. Click the Start button to start writing the firmware. 

 

Figure 6-22   Button to Start Writing the Firmware 
 
If the Authentication dialog box (shown below) appears when you start a write, enter the preset ID code, 
and then click the OK button. 

If no ID code has been preset, use the initial value as is. 

 

Figure 6-23   Authorization by an ID Code 
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Writing the firmware starts. The write is completed successfully when the “Operation completed” message is 
displayed at the bottom of the screen as shown in the following figure. 

 

Figure 6-24   Message Appearing When Writing Firmware Is Completed 
 

When you write the firmware, a communication error, such as the one shown in the following figure, may 
occur at the time of connection to the target board. If such an error occurs, try again by clicking the Start 
button. If connection fails again, detach and re-attach the USB cable of the target board, and then try again. 

 

Figure 6-25   Example of a Communication Error (Framing Error) 
 

After you perform demonstration by setting the J16 for RUN mode on the target board (CK-RX65N), you may 
want to write the initial firmware again from Renesas Flash Programmer. In this case, if you fail to set the J16 
for DEBUG mode, the error shown in the following figure occurs.  
When you use Renesas Flash Programmer to write firmware, make sure that the J16 is set for DEBUG 
mode. 

 

Figure 6-26   Example of a Connection Error 
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6.1.4 Executing the Initial Firmware 
The following explains how to set AWS IoT information in the Tera Term terminal software by running 
aws_ryz014a_tsip_ck_rx65n. The information set by this process is written to data flash memory. Install Tera 
Term by referring to section 2.1 in the following application note: “RX Family How to implement FreeRTOS 
OTA using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” (R01AN7037). 

 

(1) Start Tera Term, and then, from the File menu, select New Connection. In the dialog box that opens, 
select the Serial radio button, and then click OK. 

 

Figure 6-27   Selecting “Serial” 
(2) From the Setup menu, select Terminal. In the New-line area of the dialog box that appears, select 

AUTO for Receive and CR+LF for Transmit. 

 

Figure 6-28   Settings in the Terminal Software 
  

https://www.renesas.com/search?keywords=r01an7037
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(3) From the Setup menu, select Serial port. In the dialog box that appears, set Speed to 115200, and 
then click New setting. For the other settings, do not change their initial values. 

 

Figure 6-29   Communication Speed Settings 
(4) On the CK-RX65N, set the J16 for RUN mode, and then press the RESET switch. After a hardware 

reset occurs, the program starts.  
After the program starts, the operating status is displayed in the Tera Term window. 

 

Figure 6-30   Setting RUN Mode and Performing a Hardware Reset 
  



RX Family 
OTA Update in FreeRTOS by Implementing TLS Communication Using the TSIP Driver 

R20AN0749EJ0100  Rev.1.00  Page 84 of 102 
Jun.14.24  

(5) The bootloader starts, and then, after verification finishes, the demo application starts.  
When the demo application starts, a menu is displayed. When this menu is displayed, enter “CLI” within 
10 seconds, and then press the Enter key. The application enters CLI mode. In CLI mode, you can 
register various kinds of information in the program by using commands.  
If you do not enter “CLI” for 10 seconds or more, a sequence for connection to AWS starts. 

 

Figure 6-31   Screen for Executing the Demo Application 
 

6.1.5 Registering the AWS IoT Information 
This section describes how to register various information necessary to establish a connection to AWS via 
TLS communication using the TSIP. After starting the initial firmware, enter CLI mode, and specify the 
necessary settings.  
In CLI mode, you can use commands to set values and check set values.  
The values set in CLI mode are saved in data flash memory. Therefore, the settings are maintained even 
when the power to the target board is turned off. 

 

(1) Setting the AWS connection information 

Register the name and endpoint of the device (thing) set in Chapter 3, AWS Setup in CLI mode. 

Use Tera Term to enter CLI mode, and then execute the following commands: 

conf set thingname thing-name [Enter] 
conf set endpoint endpoint-name [Enter] 

 

Figure 6-32   Inputting AWS Connection Information from CLI 
  

A bootloader started and 
performed verification of the demo 
application. 

The demo application menu is 
displayed. 

The mode changed to 
CLI. 
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(2) Registering the client certificate 

In CLI mode, register the client certificate that was downloaded from AWS in section 5.1.3, Obtaining a Key 
Pair and Client Certificate for RSA. 

In Tera Term, enter “conf set cert ”, and then transmit the client certificate file (xxxx-certificate.pem.crt) by 
dragging it to Tera Term. (Note: Place a halfwidth space after “cert”.) 

After dragging the file, move the focus to Tera Term, and then press the Enter key. 

  
 

 

Figure 6-33   Inputting the Client Certificate 
  

Enter “conf set cert ”, and then drag the certificate 
file to Tera Term.  
Then, press the Enter key. 
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(3) Registering the root CA certificate 

In CLI mode, register the root CA certificate that was downloaded from AWS in section 5.1.2, Obtaining a 
Root CA Certificate. 

In Tera Term, enter “conf set rootca ”, and then transmit the root CA certificate file (AmazonRootCA1.pem) 
by dragging it to Tera Term. (Note: Place a halfwidth space after “rootca”.) 

After dragging the file, move the focus to Tera Term, and then press the Enter key. 

 

 
 

 

Figure 6-34   Inputting the Root CA Certificate 
  

Enter “conf set rootca ”, and then drag the 
certificate file to Tera Term.  
Then, press the Enter key. 
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(4) Registering the key pair certificate (ECDSA certificate) for an OTA update 

In CLI mode, register the key pair certificate that was generated in section 5.2, Generating a Key Pair and 
Certificates for an OTA Update. 

In Tera Term, enter “conf set codesigncert ”, and then transmit the key pair certificate file (secp256r1.crt) by 
dragging it to Tera Term. (Note: Place a halfwidth space after “codesigncert”.) 

After dragging the file, move the focus to Tera Term, and then press the Enter key. 

Note:  Before transmitting the file, make sure that the line break code in the certificate file is LF. If the 
line break code is not LF, convert it by using a text editor. 

  
 

 

Figure 6-35   Inputting the Key Pair Certificate for OTA Update 
  

Enter “conf set codesigncert ”, and drag the 
certificate file to Tera Term.  
Then, press the Enter key. 
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(5) Committing the AWS IoT settings (writing the settings to data flash memory) 

After the settings are input from CLI, write them to data flash memory. The input settings are not saved until 
“commit” is executed. Always execute “commit” the settings before turning off the power to the board. 

Once you commit the settings, they are retained even after turning power off. 

In Tera Term, execute the following command: 

conf commit[enter] 
When you execute “commit”, the following text is displayed: 

 

Figure 6-36   Writing the Settings to Data Flash by Executing “commit” 
 
(6) Deleting the written settings from the data flash memory 

After data is written to the data flash memory by executing “commit”, you can delete the data.  
When you input new settings and execute “commit” again, the existing settings are replaced by the new 
settings. Therefore, you do not need to delete the written data ordinarily. Perform deletion when you want to 
clear the data flash memory. 

Note that the three keys used for the TSIP (root CA certificate signature verification public key, client 
certificate public key, and client certificate private key) are written to the data flash memory when the 
program is executed for the first time.  
These keys cannot be accessed from CLI. Therefore, if you want to change them, perform deletion to clear 
the data flash memory. 

Note: If you re-execute the script in section 5.1.4 or regenerate the three types of keys in section 5.1.5, be 
sure to clear the data flash with this operation. 
Also, after clearing the data flash, execute steps (1) to (4) again. 
As a result, when the program runs, three new recreated keys are written to the data flash. 
 

In Tera Term, execute the following command: 

format[enter] 
 

When you perform deletion, the following text is displayed. Because all settings in the data flash memory are 
cleared, specify new settings. 

 

Figure 6-37   Deleting the Settings in the Data Flash Memory 
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(7) Resetting the program and executing the initial firmware 

After the settings are input completely, when you reset the program, connection to AWS starts. 

In Tera Term, execute the following command: A software reset occurs, and the program restarts from the 
beginning. 

reset[enter] 
 

When “reset” is executed, Tera Term displays the communication log data as shown in the following figure. 

After TLS communication using the TSIP starts, PubSub Demo and OTA Demo tasks are performed. 
PubSub Demo demonstrates verification of MQTT communication, and OTA Demo demonstrates a firmware 
update. 

In the log, confirm that the program already executed PubSub Demo and is waiting for the OTA update job to 
start. 

 

Figure 6-38   Executing the Initial Firmware 
  

Keys for the TSIP were written to the data flash 
memory. 
Note: This process is performed only when no keys 

are written. 

The TSIP driver started. 

Connection to the AWS server 
succeeded. 

The version of the initial firmware 
is 0.9.2. 

The program is 
waiting for the OTA 
update job to start. 

PubSub (MQTT) Demo was executed. 
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6.1.6 Verifying the Status of MQTT Communication 
This section describes how to verify the status of MQTT communication. 

The status of MQTT communication can be verified in AWS. Before executing the program, specify the AWS 
monitor settings by using the procedures described below. 

(1) Signing in to AWS Management Console 

Sign in to AWS Management Console (https://aws.amazon.com/console/), and then open the IoT Core 
window by using the AWS menu. To do this, in the menu to the left of IoT Core, under Test, select MQTT 
test client to open the MQTT test client. 

 

Figure 6-39   AWS IoT Menu 
  

https://aws.amazon.com/console/
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(2) Subscribing to a topic 

Click the Subscribe to a topic tab, enter a hashmark (#) as a wildcard in Topic filter, and then click 
Subscribe. 

 

Figure 6-40   Specifying the MQTT Test Client Settings 
(3) Confirming that a blank console appears 

Confirm that a blank console is displayed at the bottom of the window as shown in the following figure. 

 

Figure 6-41   Confirming That a Blank Console Is Displayed 
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(4) Executing the program 

Press the reset switch on the target board to reset and restart the program by referring to section 6.1.4(4). 
When the program starts, the progress of executing PubSub Demo (MQTT communication tasks) is 
displayed as shown in the following figure. 
PubSub Demo performs two MQTT communication tasks, Task 0 and Task 1.  
Each PubSub task sends 10 messages (messages 0 to 9). 

 

Figure 6-42   Progress of Executing PubSub Demo 
  

Task 0 sent message 0. 

Task 1 sent message 0. 
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(5) Viewing the communication log in the MQTT test client window 

If you open the MQTT test client window of AWS during execution of PubSub Demo, you can view the 
communication log. 
When PubSub Demo successfully connects to AWS, a message to that effect is output to the communication 
log on the MQTT client.  
The following figure shows an example of a message output when message 5 is received from Task 0. 

 

Figure 6-43   Viewing the MQTT Communication Log 
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6.2 Building and Executing Update Firmware 
This section describes how to create update firmware to be used in an OTA update. In this application note, 
you create update firmware by only changing the version number of the project for the initial firmware 
“aws_ryz014a_tsip_ck_rx65n” created in section 6.1. 

 

6.2.1 Creating Update Firmware 
(1) Changing the firmware version to 0.9.3 

The following figure shows the section to be changed in the “aws_ryz014a_tsip_ck_rx65n” project.  
In the aws_ryz014a_tsip_ck_rx65n\src\frtos_config\demo_config.h file, change the value of the 
APP_VERSION_BUILD definition to 3 so that the version number changes to 0.9.3. When the change is 
completed, rebuild the project. 

 

Figure 6-44   Changing the Version Number of the Update Firmware 
  

(2) Using Renesas Image Generator to generate update firmware 

Confirm that you have update firmware that was rebuilt in section 6.2.1(1) 
(aws_ryz014a_tsip_ck_rx65n.mot). Then, copy it to the Renesas Image Generator folder, overwriting the 
existing file with the same name, and then execute the following command in the Command Prompt window: 

python image-gen.py -iup aws_ryz014a_tsip_ck_rx65n.mot -ip 
RX65N_DualBank_ImageGenerator_PRM.csv -o user_093 -key secp256r1.privatekey -
vt ecdsa -ff RTOS 

 

Figure 6-45   Creating Update Firmware 
Generation is complete when the following message is displayed on the command line: “Successfully 
generated the user_093.rsu file.” 

The update firmware is created with the following file name: 

• user_093.rsu 
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6.2.2 Updating the Firmware 
This section describes how to create an OTA update job that updates firmware. You create this job in AWS. 

Before you create the job, execute the initial firmware on the target board and make sure that the program is 
waiting for the OTA update job to start by using the procedure described in section 6.1.5(7). 

 

(1) Creating a firmware update job in AWS IoT Core 

Before creating a firmware update job, register the update firmware in AWS. For details on the procedure, 
refer to “5.2 Updating the firmware” in the following application note: “RX Family How to implement 
FreeRTOS OTA using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” 
(R01AN7037). 

Note that creation of an OTA update job requires the ECDSA certificates and keys created in section 5.2, 
Generating a Key Pair and Certificates for an OTA Update. Be sure to use the same data that was generated 
and used when the initial firmware was created. 
When the OTA update job is created, OTA update is executed to update the firmware. 

 

Figure 6-46   Executing the OTA Update Job 
  

https://www.renesas.com/search?keywords=r01AN7037
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(2) Receiving firmware 

When the OTA update job starts, processing to receive firmware starts on the target board. 

The firmware is received in units of blocks. The value of “Received” is incremented each time a block is 
received. When the value of “Number of blocks remaining” becomes 0, reception is complete. 

 

Figure 6-47   Log Data Displayed During Firmware Reception 
(3) Completion of firmware reception 

When all the firmware data is received and the firmware is successfully verified, the firmware is written, the 
banks are swapped, and then the update firmware is executed. 
When the update firmware is executed normally, the initial menu is displayed. 

 

Figure 6-48   Completion of Firmware Reception 
  

When reception starts, the 
“Received” value increases.  

After a restart, the menu is 
displayed. 

Firmware reception 
finished and banks were 
swapped. 

The number of remaining blocks 
to be received is displayed. 
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(4) Confirming the firmware version 

Confirm that the version number of the firmware is 0.9.3, which is the version number of the update firmware. 
If the PubSub Demo and OTA Demo operate in the same way as the initial firmware, the firmware update is 
complete. 

 

Figure 6-49   Confirming the Firmware Version 
  

Firmware version is 0.9.3. 
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7. Appendix 
7.1 Notes on Executing the Sample Program on Multiple Devices Concurrently in 

the Same LAN Environment 
The sample code (ethernet version)  includes MAC addresses assigned to vendor IDs of Renesas 
Electronics. 
If you execute the sample program on multiple devices concurrently in the same LAN environment, make 
sure that the MAC addresses of each instance of the sample program are unique. 
If multiple instances of the sample program having the same MAC addresses are executed on multiple 
devices concurrently, they may not operate correctly. 
The following shows the procedure for changing the MAC addresses. 
 
Open Smart Configurator (aws_ether_tsip_ck_rx65n.scfg), and then select the Components tab.  
In the tree view, select RTOS > RTOS Kernel > FreeRTOS_Kernel. Then, in the list box that appears in the 
right pane, change the value of the “MAC address 0” to “MAC address 5” properties to any hexadecimal 
values of your choice.  
Specify “0x” followed by a two-digit hexadecimal number for each property. 

Customers who create their own products from the sample program must use MAC addresses that the 
customers themselves obtained from IEEE. 

 
Figure 7-1   MAC Address Settings 

After you have changed the settings as described above, click the Generate Code button at the top right of 
the window. The changes (made in Smart Configurator) are applied to the relevant code. 
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Figure 7-2   Generating Code 
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8. Troubleshooting 
The following table shows problems that may occur when the sample program is executed and their 
solutions. 

 

Table 8-1   Troubleshooting (1) 

No. Problem Cause Solution Reference 
1 The command 

that creates the 
initial firmware 
fails. 

The path to Python 
is unknown. 

Re-install Python.  
At this time, make sure that the Add 
python.exe to PATH check box is 
selected. *2 

*1 

2 No cryptographic 
library is installed. 

Install a cryptographic library. *2 

3 The initial 
firmware 
cannot be 
written. 

The CK-RX65N is 
not set in DEBUG 
mode. 

On the CK-RX65N, make sure that J16 pins 
1 and 2 are closed to set DEBUG mode. 

*3 

4 The initial 
firmware 
cannot be 
started. 

The CK-RX65N is 
not set in RUN 
mode. 

On the CK-RX65N, make sure that J16 pins 
2 and 3 are closed (RUN mode). 

6.1.4(4) 

5 Cellular 
communication 
cannot be 
started. 

The RYZ014A 
PMOD expansion 
board is not 
connected 
correctly. 

Review the connection of the RYZ014A 
PMOD expansion board. 

*3 

6 No SIM card is 
inserted. 

Insert a SIM card. *3 

7 The SIM card 
settings are not 
specified correctly. 

Review the configuration settings of the 
“r_cellular” module. 

6.1.2(4) 

8 The SIM card 
bundled with the 
CK-RX65N is used 
and is not 
activated. 

Activate the SIM card. 6.1.2(4) 

9 An error occurs 
during cellular 
communication. 

The communication 
environment is 
poor. 

Connect an antenna and power supply to 
the RYZ014A PMOD expansion board. 
Also make sure that the antenna is placed 
at a window or another location where 
communication quality is good. 

*3 

Notes: 1. Section 2.2 in the following application note: “RX Family How to implement FreeRTOS OTA using 
Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” (R01AN7037) 

 2. Section 2.2(5) in the following application note: “RX Family How to implement FreeRTOS OTA 
using Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” (R01AN7037) 

 3. Section 2.5 in the following application note: “RX Family How to implement FreeRTOS OTA using 
Amazon Web Services in RX65N (for v202210.01-LTS-rx-1.1.3 or later)” (R01AN7037) 

  

https://www.renesas.com/search?keywords=r01an7037
https://www.renesas.com/search?keywords=r01an7037
https://www.renesas.com/search?keywords=r01an7037
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Table 8-2   Troubleshooting (2) 

No. Problem Cause Solution Reference 
10 Connection to 

AWS fails. 
AWS IoT information is 
not set or incorrect AWS 
IoT information is set. 

Set the AWS IoT information 
again. 

6.1.4 

11 The data of certificates 
and keys is not created 
or registered normally. 

Create the data of certificates and 
keys again by using the correct 
procedures. 

5.1 

12 Firmware does 
not start after the 
bootloader is 
started. 

A public key is not 
correctly set in the 
bootloader. 

Review the public key settings in 
the bootloader. 

6.1.2(1) 

13 Firmware does 
not start after 
OTA update is 
performed. 

A public key is not 
correctly set in the 
firmware. 

Review the public key settings in 
the firmware. 

6.2.1(2)  

14 The device selection 
settings are not correctly 
specified. 

Review the device settings in the 
firmware and bootloader. 

6.1.5 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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